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Introduction

Thanks for choosing Wingware’s Wing IDE! This manual will help you get started and
serves as a reference for the entire feature set of this product.

The manual is organized by major functional area of Wing IDE, including source code
editor, project manager, source browser (Wing IDE Professional only), and debugger.
Several appendices document the entire command set, provide pointers to resources and
tips for Wing and Python users, and list the full software license.

The rest of this chapter describes how to install and start using Wing IDE. If you hate
reading manuals, you should be able to get started by reading this chapter only, or try
the quick start guide or tutorial.

Key Concepts
Throughout this manual, key concepts, important notes, and non-obvious features
are highlighted in the same way as this paragraph. If you are skimming only, look
for these marks.

1.1. Product Levels

This manual is for the Wing IDE Professional product level of the Wing IDE product
line, which currently includes Wing IDE Professional, Wing IDE Personal, and Wing
IDE 101.

Wing IDE Professional is the full-featured Wing IDE product, and may be licensed for
commercial or non-commercial uses. Wing IDE Personal is for non-commercial use only
and contains a subset of the features found in Wing IDE Professional. Both products
are commercial products for sale from our website; Wing IDE Personal is not a free
download.

Wing IDE 101 is a heavily scaled back IDE that was designed for teaching entry level
computer science courses. It is free to download and use for educational and personal
use.

11
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Wing IDE Professional, Wing IDE Personal, and Wing IDE 101 are independent prod-
ucts and may be installed at the same time on your system without interfering with each
other.

For a list of features in each product level, please  refer to
http://wingware.com/wingide /features.

1.2. Licenses

Wing IDE is licensed per developer, and requires a separate license for each class of
operating system (Windows, Linux, or OS X) that is used by the developer. For the full
license text, see the Software License.

License Activation

To run for more than 10 minutes, Wing IDE requires activation of a time-limited trial
or permanent purchased license. Time-limited trials last for 10 days and can be renewed
several times.

An activation ties the license to the machine through a series of checks of the hardware
connected to the system. This information is never transmitted over the internet. Instead
an SHA hash of some of the values is passed back and forth so that the machine will be
identifiable without us knowing anything specific about it.

The machine identity metrics used for activation are designed to be forgiving so that
replacing parts of your machine’s hardware or upgrading the machine will usually not
require another activation. By the same token, activating multiple times on the same
machine (for example if the activation file is lost) usually does not increase your activa-
tion count.

Licenses come with three activations by default and additional activations can be ob-
tained from the self-serve license manager or by emailing sales at wingware.com. As a
fall-back in cases of emergency where we cannot be contacted and you don’t have an
activation, Wing IDE will run for 10 minutes at a time without any license at all.

See Installing Your License for more information on obtaining and activating licenses.

1.3. Supported Platforms

This version of Wing IDE is available for Microsoft Windows, Linux, Mac OS X (with
X11 Server), and some other operating systems where customers compile the product
from source code.


http://wingware.com/wingide/features
http://wingware.com/license
mailto:sales@wingware.com
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Microsoft Windows

Wing IDE supports Windows 2000, XP, 2003 Server, and Vista. Windows 95, 98, and
ME are not supported and will not work. Windows N'T4 is not supported but may work
with IE5+ installed.

Linux/Intel

Wing IDE runs on Linux versions with glibc2.2 or later (e.g. RedHat 7.1+, Mandrake
8.0+, SUSE 7.1+, and Debian 3.0+).

On Suse, you may need to install the gmp and python packages, or install Python from
source, since Python is not installed by default here.

Mac OS X

Wing IDE runs on Mac OS X 10.3.94. Wing IDE for OS X also requires an X11 Server
and Window Manager. For details see OS X Quick Start Guide.

Only Python 2.2 and later are supported for Mac OS X. OS X 10.3 and later come with
a standard version of Python already installed.

Other Platforms

Wing IDE can be compiled from source by customers wishing to use it on other operating
systems (such as Linux PPC, Free BSD, or Solaris). This requires a non-disclosure
agreement.

Some contributed builds of Wing IDE for other operating systems may be available from
time to time.

1.4. Supported Python versions

Wing supports CPython 1.5 through 2.5 and Stackless Python 2.4 and 2.5. Wing can
also be used with IronPython and Jython, but the debugger will not work with these
implementations of Python.

Wing’s debugger is pre-built for each of these versions of Python with and without -
-with-pydebug. Both 32-bit and 64-bit compilation are supported on Windows and
Linux. CPython --with-framework builds are also supported on OS X. If necessary, it
is possible for customers to compile Wing’s debugger against other custom versions of
Python.

Before installing Wing, you may need to download Python and install it if you do not
already have it on your machine.


http://wingware.com/pub/wingide/support/source-non-discl.pdf
http://wingware.com/pub/wingide/support/source-non-discl.pdf
http://wingware.com/downloads/contrib
http://python.org/download
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On Windows, Python must be installed using one of the installers from the python.org
(or by building from source if desired).

On Linux, most distributions come with Python. Installing Python is usually only
necessary on SUSE or a custom-built Linux installation.

On SUSE Linuz, you can install the gmp and python packages that come with your
distribution, or install from the materials available through the links given above.

On Mac OS X, Wing IDE only supports Python 2.2 and later.

1.5. Technical Support

If you have problems installing or using Wing IDE, please submit a bug report or feedback
using the Submit Bug Report or Submit Feedback items in Wing IDE’s Help menu.

Wingware Technical Support can also be contacted by email at support at wingware.com,
or online at http://wingware.com/support.

Bug reports can also be sent by email to bugs at wingware.com. Please include your OS
and product version number and details of the problem with each report.

If you are submitting a bug report via email, see Obtaining Diagnostic Output for
more information on how to capture a log of Wing IDE and debug process internals.
Whenever possible, these should be included with email-based bug reports.

1.6. Prerequisites for Installation
To run Wing IDE, you will need to obtain and install the following, if not already on
your system:

Prerequisites for all platforms:

e Downloaded or CD version of Wing IDE
e A supported version of Python

e A working TCP/IP network configuration (for the debugger; no outside access to
the internet is required)

Additional Prerequisities for Mac OS X:


mailto:support@wingware.com
http://wingware.com/support
mailto:bugs@wingware.com
http://wingware.com/downloads
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e An X11 window server, such as Apple X11 for OS X (available on the OS X install
disks) or XDarwin.

e A window manager. Apple’s X11 Server includes one; other options include Win-

dow Maker and OroborOSX

See the OS X How-To for details on installing and using Wing on OS X.

1.7. Installing

Before installing Wing IDE, be sure that you have installed the necessary prerequi-
sites. If you are upgrading from a previous version, see Upgrading first.

Note: On all platforms, the installation location for Wing IDE is referred to as
WINGHOME.

Windows 2000 and XP

Install Wing IDE by running the downloaded executable. Wing’s files are installed by
default in C:\Program Files\Wing IDE 3.0, but this location may be modified dur-
ing installation. Wing will also create a User Settings Directory in the location
appropriate for your version of Windows. This is used to store preferences and other
settings.

Linux (glibc 2.2+)

Use the RPM, Debian package, or tar file installer as appropriate for your system type.
Installation from packages is at /usr/lib/wingide3.0 or at the selected location when
installing from the tar file. Wing will also create a User Settings Directory in
~/.wingide3, which is used to store preferences and other settings.

For more information, see the Linux installation details.
Mac OS X 10.3+

Wing IDE on Mac OS X requires that you first install an X11 Server. For details on
installing and running on OS X, see the OS X Quickstart.

1.8. Running the IDE

For a quick introduction to Wing’s features, refer to the Wing IDE Quickstart Guide.
For a more gentle in-depth start, see the Wing IDE Tutorial.


http://www.xdarwin.org/
http://www.windowmaker.info/
http://www.windowmaker.info/
http://oroborosx.sourceforge.net/

16

On Windows, start Wing IDE from the Program group of the Start menu. You can
also start Wing from the command line with wing.exe (located inside WINGHOME).

On Linux/Unix, just execute wing3.0 (or wing located inside WINGHOME)

On Mac OS X, start Wing IDE by double clicking on the app folder. If you launch
Wing from the command line using Contents/Mac0S/wing inside the Wing IDE app
folder, then you will need to start your X11 Server manually first and may need to set
your DISPLAY environment variable.

1.9. Installing your License

Wing IDE requires a time-limited trial or permanent license and the license needs to be
activated on each machine (see the Licenses section for general information). When
Wing IDE is first started, you can obtain a trial licence, purchase a permanent license,
install & activate a permanent license, or use Wing for up to 10 minutes without any
license:

Mo License Found =0 *]

Wing is running without a valid license. You may now:
El Obtain or extend a trial license
Purchase a permanent license

Install and activate a permanent license.
Enter license id:

10 minute emergency session

EQ Continue | X Cancel

Trial Licenses

Trial licenses allow evaluation of Wing IDE for 10 days, with an option to extend the
evaluation twice for up to 30 days total (or more on request). The most convenient way
to obtain a trial license is to ask Wing IDE to connect directly to wingware.com (via
http, TCP/IP port 80). After the trial license is obtained, Wing will not attempt to
connect to wingware. com (or any other site) unless you submit feedback or a bug report
through the Help menu.
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Activate Trial License = Of x|

» ConnectWing IDE directly to wingware.cam

Activate manually at http:/fwingware.com/activate. You
will need your license id TNX3P-BFECQ-CYWS9-60F2T
and request code BLX24 -LEWNK-DGEBEX-HMTWL. Then
enter the provided activation key here:

If you're unable or unwilling to connect Wing IDE directly to wingware. com, you can go
to http://wingware.com/activate and enter the license id and activation request number
obtained from Wing. After entering this information, you will be given an activation
key which you can enter into Wing’s dialog box to complete the activation. This is
exactly the same exchange of information that occurs when Wing IDE connects directly
to wingware.com to obtain a trial license.

If activation fails, Wing will provide a way to configure an http proxy. Wing tries
to detect and use proxies by default but in some cases they will need to be manually
configured. Please ask your network administrator if you do not know what proxy
settings to use.

If you run into problems or need additional evaluation time, please email us at sales at
wingware.com.

Permanent Licenses

Permanent licenses and upgrades may be purchased in the online store at
http://wingware.com/store. Permanent licenses include free upgrades through the 3.*
version series. Wing IDE Professional licenses also allow access to the product source
code via http://wingware.com/downloads (requires signed non-disclosure agreement).

Activating on Shared Drives

When Wing is installed on a shared drive (for example a USB keydrive, or on a file
server), the User Settings Directory where the license activation is stored may be
accessed from several different computers.

In this case, Wing must be activated once on each computer. The resulting extra ac-
tivations will be stored as license.actl, license.act2, and so forth, and Wing will
automatically select the appropriate activation depending on where it is running.

Obtaining Additional Activations

If you run out of activations, you can use the self-serve license manager or email us at


http://wingware.com/activate
mailto:sales@wingware.com
mailto:sales@wingware.com
http://wingware.com/store
http://wingware.com/downloads
http://wingware.com/pub/wingide/support/source-non-discl.pdf
http://wingware.com/license
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sales at wingware.com to obtain additional activations on any legitimately purchased
license.

1.10. User Settings Directory

The first time you run Wing, it will create your User Settings Directory automat-
ically. This directory is used to store your license, preferences, auto-save files, recent
lists, and other files used internally by Wing. If the directory cannot be created, Wing
will exit.

The settings directory is created in a location appropriate to your operating system.
The location is listed as your Settings Directory in the About Box accessible from
the Help menu.

These are the locations used by Wing;:
Linux/Unix -- ~/.wingide3 (a sub-directory of your home directory)

Windows -- In Wing IDE 3 within the per-user application data directory. The location
varies by version of Windows. For Windows 2000 and XP running on c: with an English
localization the location is:

c:\Documents and Settings\${username}\Application Data\Wing IDE 3
For Vista running on c: with an English localization the location is:
c:\Users\${username}\AppData\Roaming\Wing IDE 3

Wing also creates a Cache Directory that contains the source analysis cache. This is
often but not always in the same location as the above. On Windows, this directory
is usually in the per-user directory under Local Settings on 2000 and XP and under
Local on Vista. This directory is also listed in the About Box.

1.11. Upgrading

If you are upgrading within the same minor version number of Wing (for example from
3.0 to 3.0.x) this will replace your previous installation. Once you have upgraded, your
previous preferences and settings should remain and you should immediately be able to
start using Wing.


mailto:sales@wingware.com
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If you are upgrading across major releases (for example from 2.1 to 3.0), this will install
the new version along side your old version of Wing.

To install an upgrade, follow the steps described in Installing

1.11.1. Fixing a Failed Upgrade

In rare cases when upgrading within minor versions (for example 3.0 to 3.0.3), the
upgrade may fail to overwrite old files, resulting in random or bizarre behaviors and
crashing. The fix for this problem is to completely uninstall and manually remove
remaining files before installing the upgrade again.

Windows

To uninstall on Windows, run the Add/Remove Programs control panel to uninstall
Wing IDE. Then go into the directory where Wing was located and manually remove
any remaining folders and files.

Linux RPM

If you installed Wing IDE for Linux from RPM, issue the command rpm -e wingide3.O0.
Then go into /usr/1ib/wingide3.0 and remove any remaining files and directories.

Linux Debian

If you installed Wing IDE for Linux from Debian package, issue the command dpkg -r
wingide3.0. Then go into /usr/lib/wingide3.0 and remove any remaining files and
directories.

Linux Tar

If you installed Wing IDE for Linux from the tar distribution, find your Wing installation
directory and run the wing-uninstall script located there. Once done, manually remove
any remaining files and directories.

Mac OS X

On Mac OS X, just drag the entire Wing IDE application folder to the trash.

1.12. Installation Details and Options

This section provides some additional detail for installing Wing and describes installation
options for advanced users.
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1.12.1. Linux Installation Notes

On Linux, Wing can be installed from RPM, Debian package, or from tar archive.
Use the latter if you do not have root access on your machine or wish to install Wing
somewhere other than /usr/1lib/wingide3.0.

Installing from RPM:

Wing can be installed from an RPM package on RPM-based systems, such as RedHat
and Mandriva. To install, run rpm -i wingide3.0-3.0.5-1.1i386.rpm as root or use
your favorite RPM administration tool to install the RPM. Most files for Wing are placed
under the /usr/lib/wingide3.0 directory and the wing3.0 command is placed in the
/usr/bin directory.

Installing from Debian package:

Wing can be installed from a Debian package on Debian, Ubuntu, and other Debian-
based systems. To install, run dpkg -i wingide3.0-3.0.5-1.i386.deb as root or use
your favorite package administration tool to install. Most files for Wing are placed
under the /usr/lib/wingide3.0 directory and the wing3.0 command is placed in the
/usr/bin directory.

On 64-bit systems, you can install from the Debian package but need to first install
the ia32-1ibs 32 bit compatibility libraries and then install Wing with the com-
mand dpkg -i --force-architecture wingide3.0-3.0.5-1.i386.deb The package
contains what you need to run your debug process with 64-bit Python but Wing itself
runs as a 32-bit application.

Installing from Tar Archive:

Wing may also be installed from a tar archive. This can be used on systems that do
not use RPM or Debian packages, or if you wish to install Wing into a directory other
than /usr/lib/wingide3.0. Unpacking this archive with tar -zxvf wingide-3.0.5-
1-1386-1linux.tar.gz will create a wingide-3.0.5-1-1386-1inux directory that con-
tains the wing-install.py script and a binary-package.tar file.

Running the wing-install.py script will prompt for the location to install Wing,
and the location in which to place the executable wing3.0. These locations default
to /usr/local/lib/wingide and /usr/local/bin, respectively. The install program
must have read/write access to both of these directories, and all users running Wing
must have read access to both.

Using System-wide GTK:

By default, Wing IDE runs with its own copy of GTK2 and does not pick up on the



21

system-configured theme. This is done to avoid problems and bugs sometimes brought
out by binary incompatibilities in GTK versions.

On Linux versions that include GTK version 2.6 or later, you can tell Wing IDE to use
the system-defined GTK2 by setting the System GTK preference or running with the
--system-gtk command line argument.

Using the system-wide GTK2 in this way generally works quite well but may result in
crashing or display bugs due to binary incompatibilities in GTK and related libraries.
If you set the preference and Wing fails to start, specify the —-private-gtk command
line option to override the preference.

Non-ascii File Paths on Older Linux Systems:

Some older Linux versions require setting the environment variable
G_BROKEN_FILENAMES before Wing IDE’s file open/save dialog will work properly
with file paths that contain non-ascii characters. The environment variable is already
set on some systems where it is needed but this is not always the case.

1.12.2. Installing Extra Documentation

If you are using Linux/Unix, the Python manual is not included in most installations,
so you may also wish to download and install local copies of these pages.

Place the top-level of the HTML formatted Python manual (where index.html is found)
into python-manual/#.# within your Wing IDE installation. Substitute for #.# the
major and minor version of the corresponding Python interpreter (for example, for the
Python 2.3.x manual, use python-manual/2.3).

Once this is done, Wing will use the local disk copy rather than going to the web when
the Python Manual item is selected from the Help menu.

1.12.3. Source Code Installation

Source code is available to licensed users of Wing IDE Professional (non-evaluation
licenses only) who have completed a non-disclosure agreement. Upon receipt of this
agreement, you will be provided with instructions for obtaining and working with the
product source code.


http://docs.python.org/download.html
http://wingware.com/pub/wingide/support/source-non-discl.pdf
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1.13. Removing Wing IDE

Windows

On Windows, use the Add/Remove Programs control panel, select Wing IDE 3 and
remove it.

Linux/Unix
To remove an RPM installation on Linux, type rpm -e wingide3.0.
To remove an Debian package installation on Linux, type dpkg -r wingide3.O.

To remove a tar archive installation on Linux/Unix, invoke the wing-uninstall script
in WINGHOME. This will automatically remove all files that appear not to have been
changed since installation, It will ask whether it should remove any files that appear to
be changed.

Mac OS X

To remove Wing from Mac OS X, just drag its application folder to the trash.

1.14. Command Line Usage

Whenever you run wing3.0 from the command line, you may specify a list of files to
open. These can be arbitrary text files and a project file. For example, the following will
open project file myproject.wpr and also the three source files mysource.py, README,
and Makefile:

wing3.0 mysource.py README Makefile myproject.wpr

(on Windows, the executable is called wing.exe)

Wing determines file type by extension, so position of the project file name (if any) on
the command line is not important.

The following valid options may be specified anywhere on the command line:

--prefs-file - Add the file name following this argument to the list of preferences files
that are opened by the IDE. These files are opened after the system-wide and default
user preferences files, so values in them override those given in other preferences files.
Note that preferences files added this way must have all the preferences in a section
delimited by [extra-preferences] (unlike the main user preferences file, which uses
[user-preferences]).
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--new -- By default Wing will reuse an existing running instance of Wing IDE to open
files specified on the command line. This option turns off this behavior and forces
creation of a new instance of Wing IDE. Note that a new instance is always created if
no files are given on the command line.

--reuse -- Force Wing to reuse an existing running instance of Wing IDE even if there
are no file names given on the command line. This just brings Wing to the front.

--system-gtk -- (Posiz only) This option causes Wing to try to use the system-wide
install of GTK2 rather than its own version of GTK, regardless of any preference setting.
Running in this mode will cause Wing to pick up on system-wide theme defaults, but
may result in crashing or display problems due to incompatibilities in GTK and related
libraries.

--private-gtk -- (Posiz only) This option causes Wing to use its private copy of GTK2
and related libraries, regardless of any preference settings. Use of private GTK may result
in Wing not matching the system-wide theme, but also will avoid incompatibilities with
the system-wide GTK library.

--verbose -- (Posiz only) This option causes Wing to print verbose error reporting
output to stderr. On Windows, run console_wing.exe instead for the same result.

--display -- (Posiz only) Sets the X Windows display for Wing to run with. The display
specification should follow this argument, in standard format, e.g. myhost:0.0.

--use-winghome -- (For developers only) This option sets WINGHOME to be used
during this run. It is used internally and by developers contributing to Wing IDE. The
directory to use follows this argument.

--use-src — (For developers only) This option is used to force Wing to run from Python
source files even if compiled files are present in the bin directory, as is the case after a
distribution has been built.

--orig-python-path -- (For developers only) This option is used internally to indicate
the original Python path in use by the user before Wing was launched. The path follows
this argument.

--squelch-output -- (For developers only) This option prevents any output of any kind
to stdout and stderr. Used on Windows to avoid console creation.
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Customization

There are many ways to customize Wing IDE in order to adapt it to your needs or
preferences. This chapter describes the options that are available to you.

These are some of the areas of customization that are available:

e The editor can run with different personalities such as Vim, Emacs, Visual
Studio, and Brief emulation

The action of the tab key can be configured

The auto-completer’'s completion key(s) can be altered

The layout, look, and content of the IDE windows can be configured

Keyboard shortcuts can be added, removed, or altered for any Wing command

File sets can be defined to control some of the IDE features

Many other options are available through preferences

2.1. Editor Personalities

The default editor personality for Wing implements most common keyboard equivalents
found in a simple graphical text editor. This uses primarily the graphical user interface
for interacting with the editor and limits use of complex keyboard-driven command
interaction.

Emulation of Other Editors

The first thing any Vim, Emacs, Visual Studio, or Brief user will want to do is to
set the editor personality to emulate their editor of choice. This is done with the
Keyboard / Personality user interface preference.
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Under the Vim and Emacs personalities, key strokes can be used to control most of the
editor’s functionality, using a textual interaction 'mini-buffer’ at the bottom of the editor
window where the current line number and other informational messages are normally
displayed.

Related preferences that alter keyboard behaviors include Tab Key Action and Com-
pletion Keys for the auto-completer.

It is also possible to add, alter, or remove individual keyboard command mappings within
each of these personalities. See Key Equivalents for details.

2.2. User Interface Options

Wing provides many options for customizing the user interface to your needs. Preferences
can be set to control the number and style of windows used when working with the IDE,
the layout of tools within windows, display text font, size, and color, the style and
content of the toolbar, and the overall look or “theme” (including white on black and
many others).

2.2.1. Windowing Policies

Wing IDE can run in a variety of windowing modes. This is controlled by the Win-
dowing Policy preference, which provides the following options:

e Combined Tool Box and Editor Windows -- This is the default, in which
Wing opens a single window that combines the editor area with two tool box
panels.

e Separate Tool Box Windows -- In this mode, Wing IDE moves all the tools
out to a separate shared window.

e One Window Per Editor -- In this mode, Wing IDE creates one top-level win-
dow for each editor that is opened. Additionally, all tools are moved out to a
separate shared tool box window and the toolbar and menu are moved out to a
shared toolbar/menu window.

The windowing policy is used to describe the initial configuration and basic action of
windows in the IDE. When it is changed, Wing will reconfigure your projects to match
the windowing policy the first time they are used with the new setting.
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However, it is possible to create additional IDE windows and to move editors and tools
out to another window or among existing windows without changing from the default
windowing policy. This is described below.

2.2.2. User Interface Layout

When working in the default windowing policy, Wing’s main user interface area consists
of two tool boxes (by default at bottom and right, but this can be altered in Prefer-
ences) and an area for source editors and integrated help.

Clicking on an already-active notebook tab will cause Wing to minimize the entire panel
so that only the notebook tabs are visible. Clicking again will return the tool box to its
former size. The F1 and F2 keys toggle between these modes. The command Maximize
Editor Area in the Tools menu (Shift-F2) can also be used to quickly hide both tool
areas and toolbar.

In other windowing modes, the tool boxes and editor area are presented in separate
windows but share many of the configuration options described below.

Configuring the Toolbar

Wing’s toolbar can be configured by altering the size and style of the toolbar icons in
the toolbar, and whether or not text is shown in addition to or instead of icons. This is
controlled with the Toolbar Icon Size and Toolbar Icon Style preferences.

Alternatively, the toolbar can be hidden completely with the Show Toolbar preference.
Configuring the Editor Area

The options drop down menu in the top right of the editor area allows for splitting and
joining the editor into multiple independent panels. These can be arranged horizontally,
vertically, or any combination thereof. When multiple splits are shown, all the open files
within the window are available within each split, allowing work on any combination of
files and/or different parts of the same file.

The options drop down menu can also be used to change between tabbed editors and
editors that show a popup menu for selecting among files (the latter can be easier to
manage with large number of files) and to move editors out to a separate window or
among existing windows when multiple windows are open.

Configuring Tool Boxes

Each of the tool boxes can be also be split or joined into any number of sub-panels along
the long axis of the notebook by clicking on the options drop down icon in the tab area
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of the notebooks (right-clicking also works). The number of tool box splits Wing shows
by default depends on your monitor size.

The options drop down menu can also be used to duplicate tools, or move them around
among the splits or out to separate windows.

The size of each panel and the panel splits can also be altered by dragging on the dividers
between them.

All available tools are enumerated in the Tools menu, which will display the most recently
used tool of that type or will add one to your window at its default location, if none is
already present.

Creating Additional Windows

In addition to moving existing editors or tools to new windows, it is also possible to
create new tool windows (initially with a single tool) and new document windows (with
editor and toolbars if applicable to the selected windowing policy) from the Windows
menu.

Wing IDE will remember the state of all windows as part of your project file, so the
same window layout and contents will be restored in subsequent work sessions.

2.2.3. Altering Text Display

Wing tries to find display fonts appropriate for each system on which it runs, but many
users will want to customize the font style and size used in the editor and other user
interface areas. This can be done with the Source Code Font/Size and Display
Font /Size preferences.

The color of text for some file types in the editor can be controlled with the Syntax
Formatting preference.

Note that when the Source Code Background preference is set to a color other than
white, Wing will compute appropriately visible colors for text according to the chosen
background color.

The color used for text selection can also be controlled with the Text Selection Color
preference.

Changes in color preferences will often depend on the overall display theme that is
chosen, as described in the next section.
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2.2.4. Setting Overall Display Theme

Wing is based on GTK2, a cross-platform user interface toolkit that provides customiz-
able themes, which control the overall look and feel of the user interface. Wing’s default
theme varies by platform (a Windows emulation theme is used on Windows, and an OS
X like theme on OS X) and can be changed with the Display Theme preference.

In most cases, the new theme will instantly be applied to Wing’s user interface. When
switching back to default settings, a restart may be needed in some cases, as indicated
by message dialog.

Some systems with slower graphics cards may not run as well using the more colorful
3D rendered themes. In this case, using the Gtk Default theme is the best option, as
it involves no extra graphics-level processing.

System GTK on Linux

On Linux systems with GTK 2.6 or later installed, it is possible to run Wing with
the system-wide GTK installation and system-defined themes. This is controlled with
the Use System GTK preference or the --system-gtk or --private-gtk command
line arguments. Wing works reasonably well with most 2.6.x GTK2 releases, but there
still may be problems resulting from version differences. If you have any problems with
Wing’s stability or are seeing display glitches, you should use the private gtk option.

2.3. Preferences

Wing has many preferences that control features of the editor, unit tester, debugger,
source browser, project manager, and other tools.

To alter these, use the Preferences item in the Edit menu. This organizes all available
preferences by category and provides access to documentation in tooltips that are dis-
played when mousing over the label area to the left of each preference. Any non-default
values that are selected through the Preferences Dialog are stored in the user’s pref-
erences file, which is located in the User Settings Directory.

2.3.1. Preferences File Layers

Wing’s preferences manager runs on a layered set of preferences files. An installation-
wide preferences file may be placed inside WINGHOME and individual users can override
these values from the Preferences GUI in Wing’s Edit menu (or by manually placing a
preferences file in the User Settings Directory). The values given in the user-specific
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preferences file take precedence over any values in the default WINGHOME/preferences
file.

It is also possible to specify additional preferences files on the command line though the
—--prefs-file option. For example:

wing3.0 --prefs-file /path/to/myprefs

Any file specified in this way will override values stored in the per-user or installation-
wide preferences files. These files must contain all preferences in a section marked
[extra-preferences] (as opposed to [user-preferences], which is used in the regular
users preferences file).

2.3.2. Preferences File Format

While we recommend using the graphical preferences manager to alter preferences, some
users may wish to edit the underlying text files directly.

The preferences file format consists of a series of sections separated by bracketed headers.
Currently the only valid section is [user-preferences] for the file in the User Settings
Directory or [extra-preferences] for files passed on the command line with the --
prefs-file option. All other sections are ignored.

The body of each section is a sequence of lines, each of which is a name=value pair.

Each preference name is in domain.preference form, where domain is the IDE sub-
system affected and preference is the name of the specific preference (for example,
edit.personality defines the source editor’s runtime personality).

Preference values can be any Python expression that will evaluate to a number, string,
tuple, list, or dictionary (the data type is defined by each preference and will be verified
as the file is read into Wing). Long lines may be continued by placing a backslash (\\)
at the end of a line and comments may be placed anywhere on a line by starting them
with #.

If you wish to write preferences files by hand, refer to the Preferences Reference for
documentation of all available preferences.

2.4. Key Equivalents

The command a key will invoke may be modified by selecting a different key map or by
specifying a custom key binding. A custom key binding will override any binding for a
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particular key found in the keymap. Custom key bindings are set via the Custom Key
Bindings preference.

To add a binding, click the insert button, then press the key to be bound in the Key
field, and enter the name of the command to invoke in the Command field.

Key bindings defined by default or overriden by this preference will be shown in any
menu items that implement the same command. In cases where a command is given
more than one key equivalent, only the last equivalent found will be displayed (although
both bindings will work from the keyboard).

Key maps

Wing ships with several key equivalency maps found in WINGHOME, including
keymap.normal, keymap.emacs, keymap.vi, among others. These are used as default
key maps for the corresponding editor personalities.

For developing entirely new key bindings or debugging key bindings, it is possible to
create a custom key equivalency map and use it as your default map through Key Map
File preference. This is not recommended for most users, since completely replacing
the default key maps will require manual tracking of changes in commands across Wing
versions.

In a key map file, each key equivalent is built from names listed in the Key Names
section. These names can be combined as follows:

1) A single unmodified key is specified by its name alone, for example
’Down’ for the down arrow key.

2) Modified keys are specified by hyphenating the key names, for ex-
ample ’shift-Down’ for the down arrow key pushed while shift is
held down. Multiple modifiers may also be specified, as in ’ctrl-
shift-Down’.

3) Multi-key combinations can be specified by listing multiple key
names separated by a space. For example, to define a key equiv-
alent that consists of first pushing ctrl-x and then pushing the a
key by itself, use ’ctrl-x a’ as the key sequence.

The command portion of the key equivalency definition may be any of the commands
listed in section Command Reference. Use None to remove the given key equivalent
entirely.

Specifying a key binding that already exists in the default key binding simply replaces
that binding with your override.

Examples
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Here is an example of adding a key binding for a command. If the command already
has a default key binding, both bindings will work:

’Ctrl-X P’: ’debug-attach’
This example removes a key equivalent entirely:
’Ctrl-C Ctrl-C’: None

These can be combined to changes the key binding for a command without retaining its
default key binding:

’Ctrl-C Ctrl-C’: None
’Ctrl-G’: ’debug-continue’

Wing always retains only the last key binding for a given key combination. This example
binds Ctrl-X to ’quit’ and no other command:

’Ctrl-X’: ’debug-stop’
’Ctrl-X’: ’quit’

2.4.1. Key Names

(1) Key modifiers supported by Wing IDE for key bindings are:

e Ctrl -- Either control key.

e Shift -- Either shift key. This modifier is ignored with some key names, as indicated
below.

e Alt -- Not recommended for general use since these bindings tend to conflict with
menu accelerators and operating system or window manager operations.

e Command -- Macintosh command / apple key. This may be mapped to other
keys on other systems, but is intended for use on the Macintosh.

On Linux and OS X it is possible to remap the function of the Control, Alt, command,
and windows keys. In those cases, the Ctrl and Alt modifiers will refer to the keys
specified in that mapping.
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(2) The digit keys and core western alphabet keys are specified as follows:

07 17 27 37 47 57 67 77 87 97 A7 B? C? D? E7 F? G7 H? I? J7 K7 L7 M’ N7 O7 P? Q’ R’? S7 T7 U’
V., W, X, Y, Z,

(3) Most punctuation can be specified but any Shift modifier will be ignored since these
keys can vary in location on different international keyboards. Allowed punctuation
includes:

crrte#s$dcex()-_+=01{}Y\NI;:>"/7.>,<

(4) These special keys can also be used:

Escape, Space, BackSpace, Tab, Linefeed, Clear, Return, Pause, Scroll_Lock, Sys_Req,
Delete, Home, Left, Up, Right, Down, Prior, Page_Up, Next, Page_Down, End, Be-
gin, Select, Print, Execute, Insert, Undo, Redo, Menu, Find, Cancel, Help, Break,
Mode_switch, script_switch, Num_Lock,

F1, F2, F3, F4, F5, F6, F7, F8, F9, F10, F11, L1, F12, 1.2, F13, L3, F14, L4, F15, L5,
F16, L6, F17, L7, F18, L8, F19, 1.9, F20, L10, F21, R1, F22, R2, F23, R3, F24, R4, F25,
R5, F26, R6, F27, R7, F28, RS, F29, R9, F30, R10, F31, R11, F32, R12, F33, R13, F34,
R14, F35, R15,

(5) For equivalents that work with the mouse buttons, use these:

Pointer_Left, Pointer_Right, Pointer_Up, Pointer_Down, Pointer_UpLeft,
Pointer_UpRight,  Pointer_DownLeft,  Pointer_DownRight,  Pointer_Button_DAfit,
Pointer_Buttonl, Pointer_Button2, Pointer_Button3, Pointer_Button4,
Pointer_Button5,  Pointer_DblClick_Dflt,  Pointer_DblClickl,  Pointer_DblClick2,
Pointer_DblClick3, Pointer_DblClick4, Pointer_DblClick5, Pointer_Drag_DAflt,
Pointer_Dragl, Pointer_Drag2, Pointer_Drag3, Pointer_Drag4, Pointer_EnableKeys,
Pointer_Accelerate, Pointer_DfltBtnNext, Pointer_DfltBtnPrev,

(6) Keypad keys are specified like this:

KP_Left, KP_Right, KP_Up, KP_Down, KP_Home, KP_Page_Up, KP_Page_Down,
KP_End, KP_Insert, KP_Delete, KP_0, KP_1, KP_2, KP_3, KP_4, KP_5, KP_6, KP_7,
KP_8, KP_9,

(7) These will also work but ignore the Shift modifier since they tend to appear in
different locations on international keyboards:

KP_Space, KP_Tab, KP_Enter, KP_F1, KP_F2, KP_F3, KP_F4, KP_Prior, KP_Next,
KP_Begin, KP_Insert, KP_Delete, KP_Equal, KP_Multiply, KP_Add, KP_Separator,
KP_Subtract, KP_Decimal, KP_Divide,
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exclam, quotedbl, numbersign, dollar, percent, ampersand, apostrophe, quoteright,
parenleft, parenright, asterisk, plus, comma, minus, period, slash, colon, semicolon, less,
equal, greater, question, at, bracketleft, backslash, bracketright, asciicircum, underscore,
grave, quoteleft, braceleft, bar, braceright,

EuroSign, EcuSign, ColonSign, CruzeiroSign, FFrancSign, LiraSign, MillSign, NairaSign,
PesetaSign, RupeeSign, WonSign, NewSheqelSign, DongSign,

(8) Many other key names are available for use on international or special purpose
keyboards:

asciitilde, nobreakspace, exclamdown, cent, sterling, currency, yen, brokenbar, section,
diaeresis, copyright, ordfeminine, guillemotleft, notsign, hyphen, registered, macron,
degree, plusminus, twosuperior, threesuperior, acute, mu, paragraph, periodcentered,
cedilla, onesuperior, masculine, guillemotright, onequarter, onehalf, threequarters, ques-
tiondown,

leftradical, topleftradical, horizconnector, topintegral, botintegral, vertconnector,
topleftsqbracket, botleftsqbracket, toprightsqbracket, botrightsqbracket, topleftparens,
botleftparens, toprightparens, botrightparens, leftmiddlecurlybrace, rightmiddlecurly-
brace, topleftsummation, botleftsummation, topvertsummationconnector, botvert-
summationconnector, toprightsummation, botrightsummation, rightmiddlesummation,
lessthanequal, notequal, greaterthanequal, integral, therefore, variation, infinity, nabla,
approximate, similarequal, ifonlyif, implies, identical, radical, includedin, includes,
intersection, union, logicaland, logicalor, partialderivative, function, leftarrow, upar-
row, rightarrow, downarrow, blank, soliddiamond, checkerboard, ht, ff, cr, If, nl, vt,
lowrightcorner, uprightcorner, upleftcorner, lowleftcorner, crossinglines, horizlinescanl,
horizlinescan3, horizlinescan5, horizlinescan7, horizlinescan9, leftt, rightt, bott, topt,
vertbar, emspace, enspace, em3space, emdspace, digitspace, punctspace, thinspace,
hairspace, emdash, endash, signifblank, ellipsis, doubbaselinedot, onethird, twothirds,
onefifth, twofifths, threefifths, fourfifths, onesixth, fivesixths, careof, figdash, leftangle-
bracket, decimalpoint, rightanglebracket, marker, oneeighth, threeeighths, fiveeighths,
seveneighths, trademark, signaturemark, trademarkincircle, leftopentriangle, rightopen-
triangle, emopencircle, emopenrectangle, leftsinglequotemark, rightsinglequotemark,
leftdoublequotemark, rightdoublequotemark, prescription, minutes, seconds, latincross,
hexagram, filledrectbullet, filledlefttribullet, filledrighttribullet, emfilledcircle, emfille-
drect, enopencircbullet, enopensquarebullet, openrectbullet, opentribulletup, opentribul-
letdown, openstar, enfilledcircbullet, enfilledsgbullet, filledtribulletup, filledtribullet-
down, leftpointer, rightpointer, club, diamond, heart, maltesecross, dagger, doubledag-
ger, checkmark, ballotcross, musicalsharp, musicalflat, malesymbol, femalesymbol,
telephone, telephonerecorder, phonographcopyright, caret, singlelowquotemark, dou-
blelowquotemark, cursor, leftcaret, rightcaret, downcaret, upcaret, overbar, downtack,
upshoe, downstile, underbar, jot, quad, uptack, circle, upstile, downshoe, rightshoe,
leftshoe, lefttack, righttack,



35

Multi_key, Codeinput, SingleCandidate, MultipleCandidate, PreviousCandidate, Kanji,
Muhenkan, Henkan_Mode, Henkan, Romaji, Hiragana, Katakana, Hiragana_Katakana,
Zenkaku, Hankaku, Zenkaku Hankaku, Touroku, Massyo, Kana_Lock, Kana_Shift,
Eisu_Shift, Eisu_toggle, Kanji_Bangou, Zen_Koho, Mae_Koho,

ISO_Lock, ISO_Level2_Latch, ISO_Level3_Shift, ISO_Level3_Latch, ISO_Level3_Lock,
ISO_Group_Shift, ISO_Group_Latch, ISO_Group_Lock, ISO_Next_Group,
[SO_Next_Group_Lock, ISO_Prev_Group, ISO_Prev_Group_Lock, ISO_First_Group,
ISO_First_Group_Lock, ISO_Last_Group, ISO_Last_Group_Lock, ISO_Left_Tab,
ISO_Move_Line_Up, ISO_Move_Line_Down, ISO_Partial_Line_Up, ISO_Partial_Line_Down,

I[SO_Partial_Space_Left, I[SO_Partial_Space_Right, ISO_Set_Margin_Left,
[SO_Set_Margin_Right, [SO_Release_Margin_Left, [SO_Release_Margin_Right,
ISO_Release_Both_Margins, ISO_Fast_Cursor_Left, ISO_Fast_Cursor_Right,
ISO_Fast_Cursor_Up, ISO_Fast_Cursor_Down, ISO_Continuous_Underline,

ISO_Discontinuous_Underline, ISO_Emphasize, [SO_Center_Object, ISO_Enter

dead_grave, dead_acute, dead_circumflex, dead_tilde, dead_macron, dead_breve,
dead_abovedot, dead_diaeresis, dead_abovering, dead_doubleacute, dead_caron,
dead_cedilla, dead_ogonek, dead_iota, dead_voiced_sound, dead_semivoiced_sound,
dead_belowdot,

First_Virtual_Screen, Prev_Virtual Screen, Next_Virtual Screen, Last_Virtual Screen,
Terminate_Server, AccessX_Enable, AccessX_Feedback_Enable, RepeatKeys_Enable,
SlowKeys_Enable, BounceKeys_Enable, StickyKeys_Enable, MouseKeys_Enable,
MouseKeys_Accel_Enable, Overlayl_Enable, Overlay2_Enable, AudibleBell_Enable,
Pointer_Left, Pointer_Right, Pointer_Up,

_3270_Duplicate,  _3270_FieldMark,  _3270_Right2, 3270_Left2,  _3270_Back-
Tab, _3270_EraseEOF, _3270_Eraselnput, 3270_Reset, _3270_Quit, _3270_PAl,
_3270_PA2, _3270_PA3, _3270_Test, 3270_Attn, _3270_CursorBlink, __3270_AltCur-
sor, _3270_KeyClick, 3270_Jump, _3270_Ident, _3270_Rule, __3270_Copy, _3270_Play,
_3270_Setup, 3270_Record, _3270_ChangeScreen, _3270_DeleteWord, _3270_ExSelect,
3270_CursorSelect, _3270_PrintScreen, _3270_Enter,

Agrave, Aacute, Acircumflex, Atilde, Adiaeresis, Aring, AE, Ccedilla, Egrave, Ea-
cute, Ecircumflex, Ediaeresis, Igrave, lacute, Icircumflex, Idiaeresis, ETH, Eth, Ntilde,
Ograve, Oacute, Ocircumflex, Otilde, Odiaeresis, multiply, Ooblique, Ugrave, Uacute,
Ucircumflex, Udiaeresis, Yacute, THORN, Thorn, ssharp, agrave, aacute, acircumflex,
atilde, adiaeresis, aring, ae, ccedilla, egrave, eacute, ecircumflex, ediaeresis, igrave, ia-
cute, icircumflex, idiaeresis, eth, ntilde, ograve, oacute, ocircumflex, otilde, odiaeresis,
division, oslash, ugrave, uacute, ucircumflex, udiaeresis, yacute, thorn, ydiaeresis, Ao-
gonek, breve, Lstroke, Lcaron, Sacute, Scaron, Scedilla, Tcaron, Zacute, Zcaron, Zabove-
dot, aogonek, ogonek, lstroke, lcaron, sacute, caron, scaron, scedilla, tcaron, zacute,
doubleacute, zcaron, zabovedot, Racute, Abreve, Lacute, Cacute, Ccaron, Eogonek,
Ecaron, Dcaron, Dstroke, Nacute, Ncaron, Odoubleacute, Rcaron, Uring, Udoubleacute,
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Tcedilla, racute, abreve, lacute, cacute, ccaron, eogonek, ecaron, dcaron, dstroke, nacute,
ncaron, odoubleacute, udoubleacute, rcaron, uring, tcedilla, abovedot, Hstroke, Hcir-
cumflex, labovedot, Gbreve, Jcircumflex, hstroke, hcircumflex, idotless, gbreve, jcircum-
flex, Cabovedot, Ccircumflex, Gabovedot, Gcircumflex, Ubreve, Scircumflex, cabovedot,
ccircumflex, gabovedot, gcircumflex, ubreve, scircumflex, kra, kappa, Rcedilla, Itilde,
Leedilla, Emacron, Gceedilla, Tslash, rcedilla, itilde, lcedilla, emacron, gcedilla, tslash,
ENG, eng, Amacron, logonek, Eabovedot, Imacron, Ncedilla, Omacron, Kcedilla, Uo-
gonek, Utilde, Umacron, amacron, iogonek, eabovedot, imacron, ncedilla, omacron,
kcedilla, uogonek, utilde, umacron, OE, oe, Ydiaeresis, overline,

kana_fullstop, kana_openingbracket, kana_closingbracket, kana_comma,
kana_conjunctive, kana_middledot, kana_WO, kana_a, kana_i, kana_u, kana_e, kana_o,
kana_ya, kana_yu, kana_yo, kana_tsu, kana_tu, prolongedsound, kana_A, kana_I, kana_U,
kana_E, kana_O, kana_KA, kana_KI, kana_KU, kana_KE, kana_KO, kana_SA, kana_SHI,
kana_SU, kana_SE, kana_SO, kana_TA, kana_ CHI, kana_TI, kana TSU, kana_TU,
kana_TE, kana_TO, kana NA, kana_NI, kana_NU, kana_NE, kana_NO, kana_HA,
kana_HI, kana_FU, kana_HU, kana_HE, kana HO, kana_MA, kana_MI, kana MU,
kana_ME, kana_MO, kana_YA, kana_YU, kana_YO, kana_RA, kana_RI, kana_RU,
kana_RE, kana_RO, kana_WA, kana_N, voicedsound, semivoicedsound, kana_switch,

Arabic_comma, Arabic_semicolon, Arabic_question_mark, Arabic_hamza, Ara-
bic_maddaonalef, Arabic_hamzaonalef, Arabic_hamzaonwaw, Arabic_hamzaunderalef,
Arabic_hamzaonyeh, Arabic_alef, Arabic_beh, Arabic_tehmarbuta, Arabic_teh, Ara-
bic_theh, Arabic_jeem, Arabic_hah, Arabic_khah, Arabic_dal, Arabic_thal, Arabic_ra,
Arabic_zain, Arabic_seen, Arabic_sheen, Arabic_sad, Arabic_dad, Arabic_tah, Ara-
bic_zah, Arabic_ain, Arabic_ghain, Arabic_tatweel, Arabic_feh, Arabic_qaf, Arabic_kaf,
Arabic_lam, Arabic_meem, Arabic_noon, Arabic_ha, Arabic_heh, Arabic_waw, Ara-
bic_alefmaksura, Arabic_yeh, Arabic_fathatan, Arabic_dammatan, Arabic_kasratan,
Arabic_fatha, Arabic_.damma, Arabic_kasra, Arabic_shadda, Arabic_sukun, Ara-
bic_switch,

Serbian_dje, Macedonia_gje, Cyrillic_io, Ukrainian_ie, Ukranian_je, Macedo-
nia_dse, Ukrainian_ i, Ukranian_i, Ukrainian_yi, Ukranian_yi, Cpyrillic_je, Serbian_je,
Cyrillic_lje, Serbian_lje, Cyrillic_nje, Serbian_nje, Serbian_tshe, Macedonia_kje,
Ukrainian_ghe_with_upturn, Byelorussian_shortu, Cyrillic_.dzhe, Serbian_dze, nu-
merosign, Serbian_DJE, Macedonia_GJE, Cyrillic_1O, Ukrainian_IE, Ukranian_JE,
Macedonia_DSE, Ukrainian_I, Ukranian I, Ukrainian_YI, Ukranian _YI, Cyrillic_JE,
Serbian_JE, Cyrillic_.LJE, Serbian LJE, Cyrillic. NJE, Serbian NJE, Serbian TSHE,
Macedonia_KJE, Ukrainian GHE_WITH_UPTURN, Byelorussian SHORTU, Cyril-
lic. DZHE, Serbian_DZE, Cyrillic_yu, Cyrillic_a, Cyrillic_be, Cyrillic_tse, Cyrillic_de,
Cyrillic_ie, Cyrillic_ef, Cyrillic_ghe, Cyrillic_ha, Cyrillic_i, Cyrillic_shorti, Cyrillic_ka,
Cyrillic_el, Cyrillic_em, Cyrillic_en, Cyrillic_o, Cyrillic_pe, Cyrillic_ya, Cyrillic_er, Cyril-
lic_es, Cyrillic_te, Cyrillic_u, Cyrillic_zhe, Cyrillic_ve, Cyrillic_softsign, Cyrillic_yeru,
Cyrillic_ze, Cyrillic_sha, Cyrillic_e, Cyrillic_shcha, Cyrillic_che, Cyrillic_hardsign,
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Cyrillic_YU, Cyrillic_A, Cyrillic_.BE, Cyrillic. TSE, Cyrillic. DE, Cyrillic_IE, Cyril-
lic.EF, Cyrillic. GHE, Cyrillic.HA, Cyrillic_I, Cyrillic. SHORTI, Cyrillic.ZKA, Cyril-
lic.cEL, CyrilliccEM, CyrilliccEN, Cyrillic_O, Cyrillic_.PE, Cyrillic.'YA, Cyrillic_ER,
Cyrillic_ES, Cyrillic_.TE, Cyrillic_U, Cyrillic.ZZHE, Cyrillic_ZVE, CyrillicZ.SOFTSIGN,
Cyrillic_.YERU, Cyrillic_ZE, Cyrillic_SHA, Cyrillic_E, Cyrillic.SHCHA, Cyrillic_.CHE,
Cyrillicc HARDSIGN,

Greek_ALPHAaccent, Greek EPSILONaccent, Greek_ ETAaccent, Greek_ IOTAaccent,
Greek_IOTAdiaeresis, Greek_OMICRONaccent, Greek_UPSILONaccent,
Greek_UPSILONdieresis, Greek OMEGAaccent, Greek_accentdieresis,
Greek_horizbar, Greek_alphaaccent, Greek_epsilonaccent, Greek_etaaccent,
Greek_iotaaccent, Greek iotadieresis, Greek_iotaaccentdieresis, Greek _omicronaccent,
Greek_upsilonaccent, Greek_upsilondieresis, Greek_upsilonaccentdieresis,
Greek_omegaaccent, Greek ALPHA, Greek BETA, Greek GAMMA, Greek DELTA,
Greek_EPSILON,  Greek ZETA, Greek ETA, Greek THETA, Greek IOTA,
Greek KAPPA,  Greek LAMDA,  Greek LAMBDA,  Greek MU,  Greek NU,
Greek _XI, Greek OMICRON, Greek_PI, Greek RHO, Greek SIGMA, Greek TAU,
Greek_UPSILON, Greek PHI, Greek CHI, Greek_PSI, Greek OMEGA, Greek_alpha,
Greek_beta, Greek _gamma, Greek delta, Greek epsilon, Greek zeta, Greek eta,
Greek_theta, Greek_iota, Greek kappa, Greek lamda, Greek lambda, Greek mu,
Greek_nu,  Greek xi,  Greek_omicron,  Greek pi,  Greek_rho,  Greek sigma,
Greek_finalsmallsigma, Greek_tau, Greek upsilon, Greek_phi, Greek chi, Greek_psi,
Greek_omega, Greek_switch,

hebrew_doublelowline, hebrew_aleph, hebrew_bet, hebrew_beth, hebrew_gimel, he-
brew_gimmel, hebrew_dalet, hebrew_daleth, hebrew_he, hebrew_waw, hebrew_zain,
hebrew_zayin, hebrew_chet, hebrew_het, hebrew_tet, hebrew_teth, hebrew_yod, he-
brew_finalkaph, hebrew_kaph, hebrew_lamed, hebrew_finalmem, hebrew_mem, he-
brew_finalnun, hebrew_nun, hebrew_samech, hebrew_samekh, hebrew_ayin, he-
brew_finalpe, hebrew_pe, hebrew_finalzade, hebrew_finalzadi, hebrew_zade, hebrew_zadi,
hebrew_qoph, hebrew_kuf, hebrew_resh, hebrew_shin, hebrew_taw, hebrew_taf, He-
brew_switch,

Thai_kokai, Thai_khokhai, Thai_khokhuat, Thai_khokhwai, Thai_khokhon,
Thai_khorakhang, Thai_ngongu, Thai_chochan, Thai_choching, Thai_chochang,
Thai_soso, Thai_chochoe, Thai_yoying, Thai_dochada, Thai_topatak, Thai_thothan,
Thai_thonangmontho, Thai_thophuthao, Thai_nonen, Thai_dodek, Thai_totao,
Thai_thothung,  Thai_thothahan, Thai_thothong, Thainonu, Thai_bobaimai,
Thai_popla, Thai_phophung, Thai_fofa, Thai_phophan, Thai_fofan, Thai_phosamphao,
Thai_moma, Thai_yoyak, Thai_rorua, Thai_ru, Thai_loling, Thai_lu,
Thai_wowaen, Thai sosala, Thai_sorusi, Thai_sosua, Thai_hohip, Thai_lochula,
Thai_oang,  Thai_honokhuk,  Thai paiyannoi,  Thai saraa, = Thai_maihanakat,
Thai_saraaa, Thai_saraam, Thai sarai, Thai saraii, Thai saraue, Thai sarauee,
Thai_sarau, Thai_sarauu, Thai_phinthu, Thai_maihanakat_maitho, Thai_baht,
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Thai_sarae, Thai_saraae, Thai_sarao, Thai_saraaimaimuan, Thai_saraaimaimalai,
Thai_lakkhangyao, Thai_maiyamok, Thai_maitaikhu, Thai_maiek, Thai_maitho,
Thai_maitri, Thai_maichattawa, Thai_thanthakhat, Thai_nikhahit, Thai_leksun,
Thai_leknung, Thai_leksong, Thai_leksam, Thai leksi, Thai_lekha, Thai_lekhok,
Thai_lekchet, Thai_lekpaet, Thai_lekkao,

Hangul, Hangul Start, Hangul End, Hangul Hanja, Hangul Jamo, Hangul Romaja,
Hangul Codeinput, Hangul_Jeonja, Hangul_Banja, Hangul_PreHanja,
Hangul _PostHanja, Hangul_SingleCandidate, Hangul_MultipleCandidate,
Hangul PreviousCandidate, Hangul_Special, Hangul switch, Hangul Kiyeog,
Hangul SsangKiyeog, Hangul_KiyeogSios, Hangul Nieun, Hangul NieunJieuj,
Hangul_NieunHieuh, Hangul Dikeud, Hangul SsangDikeud, Hangul Rieul,
Hangul RieulKiyeog, Hangul RieulMieum, Hangul RieulPieub, Hangul RieulSios,
Hangul RieulTieut, = Hangul RieulPhieuf, = Hangul RieulHieuh, = Hangul Mieum,
Hangul_Pieub, Hangul_SsangPieub, Hangul _PieubSios, Hangul _Sios, Hangul_SsangSios,
Hangul Teung, Hangul Jieuj, Hangul SsanglJieuj, Hangul Cieuc, Hangul Khieuq,
Hangul_Tieut, Hangul_Phieuf, Hangul_Hieuh, Hangul_A, Hangul_AE,
Hangul YA, Hangul YAE, Hangul EO, Hangul E, Hangul YEO, Hangul YE,
Hangul O, Hangul WA, Hangul WAE, Hangul OE, Hangul. YO, Hangul U,
Hangul WEO, Hangul WE, Hangul WI, Hangul YU, Hangul EU, Hangul YI,
Hangul I, Hangul J_Kiyeog, Hangul _J_SsangKiyeog, Hangul J_KiyeogSios,
Hangul J_Nieun, Hangul J_NieunJieuj, Hangul J_NieunHieuh, Hangul J_Dikeud,
Hangul J_Rieul, Hangul J_RieulKiyeog, Hangul J_RieulMieum, Hangul J_RieulPieub,
Hangul_J_RieulSios, Hangul_J_RieulTieut, Hangul_J_RieulPhieuf, Hangul_J_RieulHieuh,

Hangul J_Mieum, Hangul _J_Pieub, Hangul _J_PieubSios, Hangul _J_Sios,
Hangul J_SsangSios, Hangul J_Teung, Hangul J_Jieuj, Hangul J_Cieuc,
Hangul_J_Khieuq, Hangul_J_Tieut, Hangul_J_Phieuf, Hangul_J_Hieuh,
Hangul RieulYeorinHieuh, Hangul_SunkyeongeumMieum, Hangul SunkyeongeumPieub,
Hangul PanSios, Hangul_KkogjiDalrinleung, Hangul SunkyeongeumPhieuf,
Hangul _YeorinHieuh, Hangul_AraeA, Hangul_AraeAE, Hangul_J_PanSios,

Hangul J_KkogjiDalrinleung, Hangul_J_YeorinHieuh, Korean_Won,

Armenian_eternity, Armenian_section_sign, Armenian_full stop, Armenian_verjaket,
Armenian_parenright, Armenian_parenleft, Armenian_guillemotright, Arme-
nian_guillemotleft, Armenian_em_dash, Armenian_dot, Armenian_mijaket, Arme-
nian_separation_mark, Armenian_but, Armenian_comma, Armenian_en_dash, Ar-
menian_hyphen, Armenian_yentamna, Armenian_ellipsis, Armenian_exclam, Ar-
menian_amanak, Armenian_accent, Armenian_shesht, Armenian_question, Arme-
nian_paruyk, Armenian_AYB, Armenian_ayb, Armenian_BEN, Armenian_ben, Ar-
menian_GIM, Armenian_gim, Armenian_DA, Armenian_da, Armenian_ YECH, Ar-
menian_yech, Armenian_ZA, Armenian za, Armenian E., Armenian_e, Armenian AT,
Armenian_at, Armenian_TO, Armenian_to, Armenian ZHE, Armenian zhe, Arme-
nian_INI, Armenian_ini, Armenian_ LYUN, Armenian_lyun, Armenian KHE, Arme-
nian_khe, Armenian_TSA, Armenian_tsa, Armenian_ KEN, Armenian_ken, Arme-
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nian_HO, Armenian_ho, Armenian_DZA, Armenian_dza, Armenian GHAT, Arme-
nian_ghat, Armenian TCHE, Armenian_tche, Armenian_ MEN, Armenian_men, Arme-
nian_HI, Armenian_hi, Armenian_NU, Armenian_nu, Armenian_ SHA, Armenian_sha,
Armenian_VO, Armenian_vo, Armenian_ CHA, Armenian_cha, Armenian_ PE, Arme-
nian_pe, Armenian_JE, Armenian_je, Armenian_RA, Armenian_ra, Armenian_SE,
Armenian_se, Armenian_VEV, Armenian_vev, Armenian TYUN, Armenian_tyun,
Armenian_RE, Armenian_re, Armenian_TSO, Armenian_tso, Armenian VYUN, Ar-
menian_vyun, Armenian PYUR, Armenian_pyur, Armenian KE, Armenian ke, Ar-
menian_O, Armenian_o, Armenian_FE, Armenian_fe, Armenian_apostrophe, Arme-
nian_ligature_ew,

Georgian_an, Georgian_ban, Georgian_gan, Georgian_don, Georgian_en, Georgian_vin,
Georgian_zen, Georgian_tan, Georgian_in, Georgian_kan, Georgian_las, Georgian_man,
Georgian_nar, Georgian_on, Georgian_par, Georgian_zhar, Georgian_rae, Georgian_san,
Georgian_tar, Georgian_un, Georgian_phar, Georgian_khar, Georgian_ghan, Geor-
gian_qgar, Georgian_shin, Georgian_chin, Georgian_can, Georgian_jil, Georgian_cil, Geor-
gian_char, Georgian_xan, Georgian_jhan, Georgian_hae, Georgian_he, Georgian_ hie,
Georgian_we, Georgian_har, Georgian_hoe, Georgian_fi,

2.5. File Sets

Wing provides a way to define sets of files that can be used in various ways within the
IDE, such as for searching particular batches of files and adding only certain kinds of
files to a project.

To view or alter the defined file sets, use the File Sets... item in the File menu. This
will display a file set editor within the Preferences manager.

When adding or editing a file set, the following information may be entered:

e Name - The name of the file set

e Includes - A list of inclusion criteria, each of which contains a type and a spec-
ification. A file will be included in the file set if any one of these include criteria
matches it.

e Excludes -- A list of exclusion criteria, any of which can match to cause a file to
be excluded from the file set even if one or more include matches were also found.

The following types of include and exclude criteria are supported:

e Wildcard on Filename -- The specification in this case is a wildcard that must
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match the file name. The wildcards supported are those provided by Python’s
fnmatch module.

e Wildcard on Directory Name -- The specification in this case is a wildcard
that must match the directory name.

e Mime Type -- The specification in this case names a MIME type supported by
Wing IDE. If additional file extensions need to be mapped to a MIME type, use
the Extra File Types preference to define them.

Once defined, file sets are presented by name in the Search in Files tool’s batch search
facility and in the Project tool’s batch file addition features.

Any problems encountered in using the file sets are reported in the Messages area.


http://wingware.com/psupport/python-manual/2.5/lib/module-fnmatch.html

Project Manager

The Project manager provides a convenient index of the files in your software project
and collects information needed by Wing’s debugger, source code analysis tools, and
other facilities.

To get the most out of Wing’s debugger and source analysis engine, you may in some
cases need to set up Python Executable, Python Path, and other values in Project-
Wide Properties and/or Per-File Properties.

3.1. Creating a Project

To create a new project, use the New Project item in the Project menu. This will
prompt you to save any changes to your currently open project and will create a new
untitled project. If Wing is started without any command line arguments, the most
recent project is opened, or if no project exists then the Default Project is opened.

When you create a new project, you will often want to alter some of the Project
Properties to point Wing at the version of Python you want to use, set PYTHONPATH
so Wing’s source analyzer and debugger can find your files, and set any other necessary
runtime environment for your code.

To add files to your project, use the following items in the Project menu:

e Add Directory allows you to specify a directory to include in the project. In
many cases, this is the only operation needed to set up a new project. You will
be able to specify a filter of which files to include, whether to include hidden &
temporary files, and whether to include subdirectories. The list of files in the
project will be updated as files matching the criteria are added and removed from
the disk.

e Add Current File will add the frontmost current editor file to the project if it
is not already there.

41
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e Add New File is used to create a new file and simultaneously add it to your
project.

e Add File will prompt you to select a single file to add to the project view. Note
that this also may result in adding a new directory to the project manager window,
if that file is the first to be added for a directory.

A subset of these options can be accessed from the context menu that appears when
right-clicking your mouse on the surface of the project manager window.

3.2. Removing Files and Packages

To remove a specific file, select it and use the Remove From Project menu item in the
right-click context menu from the surface of the Project Manager window, or by selecting
an item on the project and using Remove Selected Entry in the Project menu. You can
also remove a whole directory and all the files that it contains in this way.

3.3. Saving the Project

To save a new project, use Save Project As in the Project menu. Once a project file
has been saved the first time, it will be auto-saved whenever you close the project, start
a debug session, or exit Wing.

You can also save a copy of your project to another location or name with Save Project
As... in the Project menu.

Moving Project Files

When moving a project file on disk, doing so in a file browser or from the command
line may partially break the project if it is moved relative to the position of files that
it includes. Using Save Project As... in Wing instead will properly update the
relative paths that the project manager uses to locate files in the project.

3.4. Sorting the View

The project can be set to show your files in one of several modes, using the Options
menu in the top right of the project view:
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e View As Tree -- This displays the project files in true tree form. The tree
structure is based on the partial relative path from the project file.

e View As Flattened Tree -- This view (the default) shows files organized accord-
ing to their location on disk. Each directory is shown at the top level with path
names shown as partial relative paths based on the location of the project file. If
you alter the location of the project file with Save Project As..., these paths
will be updated accordingly.

e View By Mime Type -- This view organizes your files by MIME type.

3.5. Navigating to Files

Files can be opened from the project manager window by double clicking or middle
clicking on the file name, or right-clicking and using the Open in Wing IDE menu item.

Files may also be opened using an external viewer or editor by right-clicking on the file
and using the Open in External Viewer item. On Windows and Mac OS X, this opens
the file as if you had double clicked on it. On Linux, the preferences File Display
Commands and Extra Mime Types can be used to configure how files are opened.

You can also execute Makefiles, Python source code, and any executable files by selecting
the Execute Selected File item from the popup menu. This executes outside of the
debugger with any input/output occurring in the OS Commands tool. Doing so also
adds the command to the OS Commands tool, where its runtime environment can be
configured.

3.5.1. Keyboard Navigation

Once it has the focus, the project manager tree view is navigable with the keyboard,
using the up/down arrow keys, page up and page down, and home/end.

Use the right arrow key on a parent to display its children, or the left arrow key to hide
them.

Whenever a file is selected, pressing enter will open that item into an editor in Wing
IDE.
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3.6. Sharing Projects

Project File Types

There are two related formats in which you can save your project. One supports
sharing the project file with other developers, via a revision control system or other
method.

The default Project Type (accessed from Project Properties in the Project menu)
is Single User (One File). This stores all project data into a single file. The file
name for these files should end in .wpr.

To share a project file with other developers, change Project Type in the Options tab
of Project Properties to Shared (Two Files). Then save your project to obtain the
two separate project files on disk. The main project file name ends in .wpr and will
contain only shareable data. All user-specific data will be stored in a separate file with
name ending in .wpu.

If you subsequently change from a shared project back to single user, the user-specific
data will be merged back into the main project file and the file ending in .wpu will be
removed from disk.

Note that both the combined single user file and two split shared files use the same
textual file format that is used for the preferences file. See section Preferences File
Format for more information on the format itself.

3.7. Project-wide Properties

Each project has a set of top-level properties that can be accessed and edited via the
Properties item in the Project menu. These can be used to configure the Python
environment used by the debugger and the source code analysis engine, which drives
Wing’s auto completion, source index, and other capabilities. Project properties are also
provided to set options for the project and to enable and configure extensions for revision
control, Zope, and other tools.

Any string value for a property may contain environment variable references using the
$ (name) notation. Anything inside the parentheses will be interpreted as the name of
an environment variable and will be replaced with the value of the environment variable
when it used by the IDE. If the environment variable is not set, the reference will be
replaced by an empty string. The system environment, as modified by the project-wide
environment property (see below), is used to expand variable references.
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Environment

To get the most out of Wing, it is important to set these values in the Environment tab
correctly for your project:

Python Executable -- When the Custom radio button is checked and the entered field
is non-blank, this can be used to set the full path to the Python executable that should
be used when debugging source code in this project. When Use default is selected, Wing
tries to use the default Python obtained by typing python on the command line. If this
fails, Wing will search for Python in /usr/local and /usr (on Linux/Unix) or in the
registry (on Windows).

Python Path -- The PYTHONPATH is used by Python to locate modules that are imported
at runtime with the import statement. When the Use default checkbox in this area
is checked, the inherited PYTHONPATH environment variable is used for debug sessions.
Otherwise, when Custom is selected, the specified PYTHONPATH is used.

Environment -- This is used to specify values that should be added, modified, or
removed from the environment that is inherited by debug processes started from Wing
IDE and is used to expand environment variable references used in other properties.
Each entry is in var=value form and must be specified one per line in the provided
entry area. An entry in the form var= (without a value) will remove the given variable
so it is undefined. Note that you are operating on the environment inherited by the
IDE when it started and not modifying an empty environment. When the Use system
environment choice is set, any entered values are ignored and the inherited environment
is used without changes.

Debug

The following properties are defined in the Debug tab:

Initial Directory -- When the Use default radio button is checked, the initial working
directory set for each debug session will be the location where the main entry point file
(if any) or project file is located. Otherwise, when Custom is selected, the specified
directory is used or, when blank, the project file’s directory is used.

Build Command -- This command will be executed before starting debug on any source
in this project. This is useful to make sure that C/C++ extension modules are built, for
example in conjunction with an external Makefile or distutils script, before execution
is started. The build is configured through and takes place in the OS Commands tool.
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Options

These project options are provided:

Project Type -- This can be used to select whether or not the project will be shared
among several developers. When shared, the project will be written to two files, one of
which can be shared with other developers. See Project Types for details.

Preferred Line Ending and Line Ending Policy control whether or not the project
prefers a particular line ending style (line feed, carriage return, or carriage return + line
feed), and how to enforce that style, if at all. By default, projects do not enforce a line
ending style but rather insert new lines to match any existing line endings in the file.

Preferred Indent Style and Indent Style Policy control whether or not the project
prefers a particular type of indentation style for files (spaces only, tabs only, or mixed
tabs and spaces), and how to enforce that style, if at all. By default, projects do not
enforce an indent style but rather insert new lines to match any existing indentation in
the file.

Extensions

The Extensions tab of Project Properties is used to control revision control and other
add-ons on a per-project basis:

Enable Revision Control and Revision Control System are used to turn on a
particular revision control integration for this project. Currently Subversion, CVS, and
Perforce are supported.

Enable Zope2/Plone Support and Zope2 Instance Home are used for Zope 2.x
and Plone projects to provide the Instance Home directory used by Zope. This is needed
because Zope 2.x implements import magic that works differently from Python’s default
import and thus adding the instance home directory to PYTHONPATH is not sufficient.
Wing’s source analyzer needs this extra clue to properly find and process the Zope
instance-specific sources.

When this option is activated, Wing will also offer to add the relevant Zope2/Plone files
to the project, and to install the control panel for configuring and initiating debug in
Zope2/Plone. See the Zope How-To for details.
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3.8. Per-file Properties

Per-file properties can be set by right-clicking on a source file and selecting the Prop-
erties menu item in the popup, by right-clicking on a file in the project view and
selecting File Properties, or by opening a file and using the Current File Proper-
ties... item in the Source menu. For Debug and Python Settings, values entered here
will override any corresponding project-wide values when the selected file is the current
file or the main entry point for debugging.

File Attributes

File Type -- This property specifies the file type for a given file, overriding the type
determined automatically from its file extension and/or content. This property is recom-
mended only when the Extra File Types preference cannot be used to specify encoding
based on filename extension.

Encoding -- This can be used to specify the encoding with which a file will be saved.
When it is altered for an already-open file, Wing will offer to reload the file using the new
encoding, to only save subsequently using the new encoding, or to cancel the change.
Choose to reload if the file was opened with the wrong encoding. For already-open files,
the encoding attribute change is only saved if the file is saved. If it is closed without
saving, the encoding attribute will revert to its previous setting. The encoding cannot
be altered with this property if it is being defined by an encoding comment in a Python,
HTML, XML, or gettext PO file. In this case, the file should be opened and the encoding
comment changed. Wing will save the file under the newly specified encoding.

Important: Files saved under a different encoding without an encoding comment may
not be readable by other editors because there is no way for them to determine the
file’s encoding if it differs from the system or disk default. Wing stores the selected
encoding in the project file, but no mark is written in the file except for those encodings
that naturally use a Byte Order Mark (BOM), such as utf_16_le, utf_16_be, utf_32_le,
or utf_32_be. Note that standard builds of CPython cannot read source files encoded in
utfl6 or utf32.

Line Ending Style -- Specifies which type of line ending (line feed, carriage return, or
carriage return and line feed) is used in the file. When altered, the file will be opened
and changed in an editor. The change does not take effect until the file is saved to disk.

Indent Style -- This property can be used in non-Python files to change the type of
indent entered into the file for newly added lines. For Python files, the only way to alter
indentation in a file is with the Indentation manager.

Read-only on Disk -- This property reflects whether or not the file is marked read-only
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on disk. Altering it will change the file’s disk protections for the owner of the file (on
Posix, group/world permissions are never altered).

Editor

These properties define how the file is displayed in the editor:

Show Whitespace -- This allows overriding the Show White Space preference on a
per-file basis.

Show EOL -- This allows overriding the Show EOL preference on a per-file basis.

Show Indent Guides -- This allows overriding the Show Indent Guides preference
on a per-file basis.

Ignore Indent Errors -- Wing normally reports potentially serious indentation incon-
sistency in Python files. This property can be used to disable this check on a per-file
basis (it is also available in the warning dialo